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Setting Up the Digital Camera

Connect your digital camera to your computer according to the instructions
laid out in the digital camera documentation.

Selecting Sources

Select a digital camera software.  Mr. Photo needs the software
accompanying with your digital camera in order to read data from the digital
camera.

Once you’ve selected software you can download the photographs from
your digital camera.

Downloading Photos from Digital Camera

Plug your Digital Camera into your computer.  By now, you should have
installed the digital camera’s software.

One click downloads the photos into Mr. Photo.  The photos will be
displayed in the Thumbnail View.

Bring Out the Best In Your Photo

After you’ve downloaded your photos, use the Instant Enhancement or
Touch up tools to bring a touch of magic to your photo.  You can eradicate
undesirable blemishes such as red eye, improve the color on someone’s
cheeks by adjusting the hue, alter the contrast and brightness or put a
golden tint on a twilight scene.
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Printing

Your can print out your own stickers, flyers and labels with Mr. Photo’s print
tool. So, whether you’re running for president or creating invitations for the
kids, click the Print icon on the Application bar and select ...

Ø Print Photo to print annotated flyers etc.

Ø Print Sticker to print sticker sized labels

Ø Print Catalog (Labels) to print various sized labels which could be
included in a catalogue.
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System Requirements

For Windows:
Ø Digital Camera plus digital camera software.

Ø Scanner, if you intend to scan photos.

Ø A PC with at least a 486 microprocessor (A Pentium processor is
recommended) and 16MB RAM.

Ø Recommend at least 30MB of hard disk space available after installation.
Mr. Photo will need this space to work in.

Ø A CDROM drive to load Mr. Photo.

Ø Super VGA display card.

For Macintosh:
Ø A Power Macintosh computer.

Ø System 7.5 or later.

Ø CD-ROM drive.

Ø Hard drive with 30MB free disk space.

Ø 16MB RAM (32MB is recommanded).

Ø At least 36MB vertual memory
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Installing Mr. Photo

For Windows:
Follow the steps below to install Mr. Photo.

Ø Insert the Mr. Photo CD into your CD-ROM drive.

Ø Follow the instructions on your screen as they appear.

For Macintosh:
To install Mr. Photo:

1. Insert the program CD into your CD-ROM drive.

2. Double click on the Presto! Mr.Photo v1.2 Installer icon to launch the
setup program.

Then follow the on-screen instructions to complete the installation.

Installing The Digital Camera Software

The digital camera contains software which must be installed before you can
download photos from it.  So, install the Digital Camera software immediately
before or after Mr. Photo.
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With Mr. Photo, you can:

Ø Create multimedia slide shows, screensavers and wallpaper
(For Macintosh: This function is not available.)

Ø Enhance your photos instantly with red-eye removal

Ø Lighten underexposed photos or darken overexposed photos

Ø Print photos, catalogs, calendars, stickers and more

Ø Download photos from a digital camera

Ø Search for photos

Ø View photos (in a slide show)
(For Macintosh: This function is not available.)

Ø Put photos on the Internet (upload to a web site)
(For Macintosh: This function is not available.)



10

Mr. Photo

Mr. Photo stores and catalogs all of your valuable photos. You can sort
photos and film "rolls" by date and title (For Macintosh: This function is not
supported.), or search by keyword, date, and other image properties. Then
drag-and-drop photos to the Application Bar to create photo masterpieces
using ready-made templates or design electronic photo albums. Click the
Slide Show icon to view selected all the photos in a "roll" of film (For
Macintosh: This function is not supported.), or drag-and-drop a photo to the
E-mail icon to send it to family and friends.

Ø Acquire photos from TWAIN digital cameras, scanners, floppy disks,
PhotoCDs, and the Internet
(For Macintosh: Macintosh also supports acquiring photos from Plug-
In compliant devices.)

Ø Catalog photos in "rolls" of film that you can customize and rearrange

Ø Enhance photos instantly (remove red-eye, adjust brightness/contract,
blur/sharpen)

Ø Drag-and-drop photos to print, e-mail, create HTML slide shows, or
post on the Internet
(For Macintosh: This function is not supported.)

Ø Drag-and-drop photos to other applications for further editing or
creative projects

Film list

Menu Bar

NewSoft Web Site

Thumbnail VIew

large view

medium view

small view

Application Bar

Tool Bar
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Ø Save photos as a screen saver or as wallpaper
(For Macintosh: This function is not supported.)

Ø Print stickers, labels, and photo catalogs

PhotoAlbum

PhotoAlbum
helps you create electronic photo albums that keep your memories alive
forever. Just drag-and-drop photos, frames, clip art, textures, and special
effects, and add voice-overs and sound effects. You can also personalize
your albums with voice-overs and sound effects, then produce album slide
shows to post on the Internet or send completed albums by e-mail.

Ø Acquire photos from TWAIN digital cameras and scanners
(For Macintosh: Macintosh also supports acquiring photos from Plug-
In compliant devices.)

Ø Create album pages from ready-made templates or create your own

Ø Rotate, resize, and enhance photos

Ø Drag-and-drop to add photos, frames, clip art, textures, and special
effects

Ø Decorate album pages with text captions, background music, narration,
and sound effects

Ø Share completed albums via e-mail or post to the Internet

Page Controls

Workspace
Photo Browser

Tool bar

Effects Palette
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Setup the Digital Camera

Connect your digital camera to your computer according to the instructions
laid out in your digital camera's documentation.

Load or Acquire photos

Loading Photos from a Digital Camera
This feature gets photos from a digital camera and puts them into Mr. Photo.

To load photos from your Digital Camera:

1. Choose the Select Digital Camera Source… command from [Input]
menu.

2. In the [Select Source] dialog box, choose the digital camera’s driver, and
then click OK.

3. Select the camera icon  in the Mr. Photo window or the Load Photos
from Digital Camera command from the [Input] menu.

4. Select all the photos or click on the individual photos you wish transfer
to your hard disk.

5. Select the Transfer Photos command from the Camera menu.  The Photos
will be transferred to the Thumbnail View and placed under a film named
Untitled.

Note: Please consul t  the  documentat ion of  your  digi tal
camera for  detai led operat ing instruct ions.

For Macintosh: Macintosh also supports acquiring photos from Plug-In
compliant devices.
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Acquiring Photos from a Scanner
To acquire photos from your scanner:

1. Choose the Select Scanner Source… command from the [Input] menu.

2. In the [Select Source] dialog box, choose scanner's driver, and then click
OK.

3. Select the scanner icon  in the Mr. Photo window or the Acquire
Photos from a Scanner command from the [Input] menu.

4. The Photo will be scanned into the Thumbnail View and placed under a
film named Untitled.

For Macintosh: Macintosh also supports acquiring photos from Plug-In
compliant devices.

Adding All Photos from Disk
Adding existing photos from your hard disk to Mr. Photo:

1. Select Add All Photos from the [Input] menu.

2. Make the necessary selections from the [Add All Photos in
Folder(s)]dialog box.
Folders with Photos: Displays only the folders that contain photos.
Include Sub-folder: Adds photos from the selected folder and the
photos in its sub-folders.
New Roll: Creates a new film for the storage of the photos you add.

3. Click OK to display the photos in Mr. Photo.

4. Name the folder by double clicking on the Untitled name in the list box
or by selecting Film's Properties… command from the [Edit] menu.

5. Enter the necessary details into the [Film Properties] dialog box and click
OK.

For Macintosh: This facility is not available.
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Adding Photos from Internet
When you browse photos on the internet, you may want to preserve some
of them.  With PhotoBag you can easily keep the photos in your hard disk.

1. Click the PhotoBag icon, , to switch to the PhotoBag window.

2. Invoke your internet browser and search for the picture you are
interested in.

3. Drag the picture directly to PhotoBag.  The picture will be added to
PhotoBag.

Note: You can add an internet  browser  to  the  Application
Bar to  make this  task  easier .

For Macintosh: PhotoBag is not supported.

Bring Out the Best in Your Photos

Using Instant Enhancement
This function will automatically adjust the contrast, brightness, highlight,
shadow and tone of the selected photo and will display several samples that
you can choose to apply on your photo.

1. Select the enhancement option you want from the lower part of the
dialog box. The After thumbnail will display the effect of the chosen
enhancement option.

2. Use the  and  buttons to adjust the magnification.

3. Click OK to finalize the enhancement.

Removing Red-eye
If you receive a photo that was taken with a flash, the use of the flash may
cause a red reflection from a subject’s eye.  To restore the eye to its original
color:

1. Select the Touch Up… command from the [Enhance] menu, or double
click a photo you want to touch up.

2. Select the Advanced button.
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3. Move and resize the square onto the red eye.  The size of the square
must not be larger than the red eye.

4. Select the Removed red-eye button.

Touching Up your Photos
1. Select the Touch Up…command from the [Enhance] menu, or double

click a thumbnail you want to touch up.

2. Make appropriate adjustments by dragging the Saturation, Brightness,
Contrast, Blur/Sharpen and Color Tint sliders.  The effect will be
displayed in the window immediately.

Show Photos via Multimedia Slide Show

Creating a Portable Slide Show
Mr. Photo can create an executable file that can be sent over Internet or e-
mail.  The receiver simply runs the file to see a slide show.

1. Select the Photos you want to be included in the slide show.

2. Select Slide Show via E-mail from the [Internet] menu.  Or, click the

Internet icon  on the Application bar.  From the Task menu, select
Portable Slideshow.

For Macintosh: This facility is not supported.

Viewing a Slide Show
A slide show can be run directly from a photo session.

1. Select the Photos you want to be included in the slide show.

2. Click the Slide Show icon, , on the Application bar and see the slide
show play on the screen.

3. Make changes if needed by clicking the setting button of the control
bar.

For Macintosh: This facility is not supported.
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Controlling Slide Shows
The default position of the Slide Show Control bar is at the bottom of the
screen.  You may click the arrow at the left-hand side to hide or show the
Control bar.

Exit Stops playing and quits the Slide Show.  (You may press the [Esc]
key on your keyboard to quit playing slide show.)

Hide Conceals Slide Show behind other active windows.

Setting Opens the [Slide Show Setting] dialog box where you can adjust
the presentation features of the show.

Save Saves all the photos or selected photos from the slide show to
disk.

For Macintosh: This facility is not supported.

Access to PhotoNet

Uploading Photos to PhotoNet
As an alternative to e-mailing or sending your photos by standard postal
mail, Mr. Photo allows you to store and share photos through PhotoNet.
Any number of your friends and family can access PhotoNet to view and
download photos.

1. Select photos you want to upload to the PhotoNet.

2. Click the Upload photos to PhotoNet… command from the [Internet]
menu.

3. Fill in the dialog box with every piece of information it requests:

If you didn't enter a specific Film ID, a few moments after clicking the OK
button, PhotoNet will display a dialog box telling you the New Film ID and
the charge for this service.
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Note: Remember to tel l  your friends the Film ID and the
User’s  Name of  the photos that  you put  on the
PhotoNet  Server .   So they can easi ly  get  the  photos .

For more detailed information about PhotoNet, please go to the the PhotoNet
web site on www . photonet . com.

For Macintosh: This facility is not supported.

Downloading Photos from PhotoNet
After you receive the Film ID, follow the steps below to get the shared
uploaded photos from PhotoNet.

1. Select Download Photos from PhotoNet command from the [Internet]
menu.

2. Fill in the dialog box with the information given by your friend informs
you.

3. Download the Photos as instructed on the PhotoNet web-page.

For more detailed information about PhotoNet, please go to the the PhotoNet
web site on www . photonet . com.

For Macintosh: This facility is not supported.

Fun With Your Photos

Saving Photos as ScreenSavers
In Mr. Photo, simply click the Save as Screen Saver command from the
[Output] menu, you can create your own screen savers with the photos you
select.

For Macintosh: This option is not available.

Saving Photos as Wallpaper
You want to decorate your desktop background? Just click the [Output]
menu and select the Save as Wallpaper (Center/Tile) command, Mr. Photo
will apply the currently selected photo to your desktop background.

For Macintosh: This option is not available.



18

Outputting HTML
Creates a personal web-page through Mr. Photo's photo-to-HTML
converter.

To create html files:

1. Select the HTML command from the [Internet] menu.

2. From the [Output HTML] dialog box, click the Browse button to locate a
path for the HTML files.

3. Click OK to output the photos in HTML format to the location you
select.

For Macintosh: This option is not available.

Creating an Album
If you have installed the Presto! PhotoAlbum, the [Design] menu will appear
on the Menu bar.  Then you can use the Album command to invoke the
program and create your album.

1. Select photos that you want to put in an Album.

2. Choose the Album… command from the [Design] menu.  Or, click on the
PhotoAlbum program icon on the Application Bar.

3. Follow the on-screen instructions of PhotoAlbum.

Compose Your Photos

Visiting a famous spot and find losing your camera?  Don't be depressed.
The Compose feature in Mr. Photo helps you to make it up easily.  Presto!
Photo Composer is a quick-and-easy tool for composing a photo with a
famous landmark.

Getting Photos
After entering the "Presto! Photo Composer" window, you can begin to load
the photos you want to put together.

1. To get "My Photos," you can



How To...

19

§ Get your photos from the photos chosen at the Mr. Photo window,
or

§ Download photos from Hard disk by clicking on "More photos"
icon

2. Simply drag and drop the desired photo to the upper frame on the left
side of the window.

3. Click on "Landmarks" icon, thumbnails of various famous spots will
show.

4. Drag and drop the desired photo to the lower frame on the left side.

5. Make sure that your photo is on the upper frame and the photo of
Landmarks is on the lower frame.  Click on the {bmc swap.bmp} icon to
swap foreground and background if necessary.

6. Click on Compose icon, or

Click on the OK button and the two photos will be brought together!

Blending Two Images Together
Presto! Photo Composer provides several tools for composing your photo in
a quick-and-easy way.

The following tools are effective only on the foreground photo.

  Move/Resize Tool

This tool changes the position, image size and orientation of the foreground
photo.

  Montage Tool

This tool erases all the pixels it passes on and dissolves the foreground
photo into the background photo.  It is most suitable for blending the edges
of the foreground photo to the background photo.

Different brush widths are provided for various usages.
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  Quick Restorer

This tool restores parts of the foreground image.

Different brush widths are provided for various usages.

  Smart Scraper

This tool functions similarly as the Scraper, but it can reserve boundaries by
dragging to make portions of a similar hue invisible.

Brushes are available in several sizes for a convenient usage.

  Scraper

This tool scrapes away portions of the foreground to reveal the background.

Brushes are available in several sizes for a convenient usage.

Note: To undo the Montage,  Restorer,  Smart  Scraper,  and
Scraper funct ions,  s imply cl ick on the r ight  mouse
but ton  and drag i t  through the  area  you want  to
recover.

Editing Your Photos
Besides the modifying tools mentioned before, several quick-and-easy tools
are provided on the left palette for adjusting the foreground and background
photos separately.  Select a photo by clicking the foreground or the
background frame.

  Flip Horizonal Tool

Flip the image from left to right.

  Flip Vertical Tool

Flip the image upside down.

  Color & Brightness Tool

Change the color and brightness of photo(s) by placing the cursor at any
point on the Color Wheel or dragging the slider below.
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  Transparancy Tool

It changes the transparent level of the foreground photo.  Drag the slider
directly to make the setting.  Dragging to the left side increases the level and
dragging to the right end to keep the original level.

  Blur Tool

It changes the blur level of the background photo by dragging the slider.
Drag the slider directly to make the setting.  By blurring the background
photo, you can make the foreground photo distinguishable.

Save Photos

Making Thumbnails
Saves selected photos in a suitable format to be shown as thumbnails on a
web page.

1. Select Make Thumbnail for Internet… command from the [Internet]
menu. Or, click the Internet icon on the Application bar.  From the Task
menu, select Make Thumbnail.

2. Enter the appropriate details into the fields in the [Making Thumbnails]
dialog box.  Click OK.

Mr. Photo will make thumbnail(s) from the selected photo(s).

Converting Photos to Other Formats
Mr. Photo can change the path and the format of the Photos you selected.

1. Select the Copy Files command from the [Output] menu.

2. In the [Copy Files] dialog box, specify a new path or click the Browse
button to locate one.

For Macintosh: Select the path from the dialog box.

3. From the Type combo box, select a file format. If you choose Original,
Mr. Photo will save the photo as its original file format.

4. Click OK.
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Send photos, Slideshows via E-mail
Have you thought of sharing beautiful and memorable photos with your
friends? Mr. Photo helps you share photos and slideshows through your e-
mail system.

1. Select the photos or slideshows you want to send by E-mail.

2. Opens the e-mail facility and attaches the photos you selected to the
mail.

For Macintosh: This facility is not supported.

Print Photos

Printing Photo
Mr. Photo allows you to print photos by choosing the Print Photo(s)
command from the [Output] menu. Before printing photos, click the Options
button at the bottom left corner of the [Print Fun] dialog box from where you
can make the selections you desired for your printing.

Printing sticker
Mr. Photo allows you to print selected photos onto the sticker paper sheet.
It can help you to create impressive stickers.

To print stickers:

1. Select the Photos you wish to print.

2. Click the Printer icon on the Application Bar, and then select the Print
Sticker from the Task bar.
In the [Print Fun] dialog box, choose your sticker paper style and, if
needed, click the Option button to make appropriate changes to your
printing selections.

Printing Catalog
Mr. Photo allows you to print photos as Catalogs. Before printing photos,
click the Options button at the bottom left corner of the [Print Fun] dialog
and make selections you are interested in.

To print catalogs:
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1. Select the Photos you wish to print.

2. Click the Printer icon on the Application Bar.

3. Choose Print Catalog from the Print Task menu to invoke the
[PrintFun] dialog box.

4. Make the appropriate settings and then click the Print button.

Note: You can set  a  paper  s ty le  for  your catalogs  by c l icking
the Paper  Sty le  but ton at  the  middle  r ight  edge of  the
[Print  Fun]  dialog box.

Search Photos or Films

Search for Photo(s) or Film
The search facility can help you find specified photos or films.

1. Click the search icon, , or select the Search Photo(s)/Film command
from the [Edit] menu.

2. Make the appropriate selections from the [Search] dialog box.

Mode pane: sets the data type you want to search and sets the
searching order and amount.

Text pane: limits your search to the key-in title, keyword or memo info of
the photos you want to search.

Date pane: limits the search to within the given "from" to "to" dates.

Image File Property pane: lets you select the image format you want to
search.

3. Click OK to begin searching.
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Use Application Bar

Adding an Application
1. Click the ADD/Remove icon, .  The [Add/Remove Applications]

dialog box will appear.

2. To add an application, type a name for the application in the Name field.

3. Enter the path of the application in the Path field.  Or, click the Browse
button to open the [Open dialog box] from where you can select the
desired application.

4. Click the Add button to add the application to the Application list.

5. Click OK to close the dialog box and place the application on the
Application bar.

For Macintosh: This facility is not supported.

Removing an Application
1. Click the ADD/Remove icon, .  The [Add/Remove Applications]

dialog box will then appear.

2. Select the application you wish to remove from the Application list box.

3. Click the Remove button. The selected application will be removed from
the list.

4. Click OK to close the dialog box and remove the application from the
Application bar.

For Macintosh: This facility is not supported.
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Communicating with Other Applications
Communicating with other applications in your computer through Mr. Photo
is very easy.  Select one of the following methods.

Application Bar

1. Select a photo from the Thumbnail View.

2. Click on a program icon you want to use on the Application Bar to
invoke the application.

PhotoBag

The PhotoBag window can stay on top of all opened windows.  In other
words, whatever window is active, you still can see the PhotoBag window.
That makes it easy when you want to work with other applications.

1. Click the PhotoBag icon, , to switch to the PhotoBag window.

2. Invoke an application and search for a picture you are interested in.

3. Drag the picture directly to PhotoBag or from PhotoBag to the invoked
application.  The picture will then be added to the PhotoBag or the
selected application.

Note: You can add the  appl icat ions  you frequent ly  use to  the
Appl icat ion Bar to  make this  task  much easier .

For Macintosh: PhotoBag is not supported.
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Window Control Buttons

Minimize the Mr. Photo window.

Toggle between Mr. Photo window and PhotoBag.

Quit Mr. Photo program.

For Macintosh: This facility is not supported.

PhotoBag

The PhotoBag window can stay on top of all opened windows.  In other
words, whatever window is active, you still can see the PhotoBag window.
That makes it easy when you want to work with other applications.

1. Click the PhotoBag icon, , to switch to the PhotoBag window.

2. Invoke an application and search for a picture you are interested in.

3. Drag the picture directly to PhotoBag or from PhotoBag to the invoked
application.  The picture will then be added to the PhotoBag or the
selected application.

Note: You can add the  appl icat ions  you frequent ly  use  to  the
Appl icat ion Bar to  make this  task  much easier .

For Macintosh: PhotoBag is not supported.
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Selecting Photos

There are several ways to select photos from the Thumbnail View.

Ø Select one photo by clicking on it with the mouse cursor.

Ø Select several photos by holding down the [Ctrl] key and clicking the
desired photos with the mouse cursor.

Ø Select all the photos in the thumbnail view by pressing the [Ctrl] and [A]
keys simultaneously.

For Macintosh: Please use the [Command] key instead of the [Ctrl] key.

Copying and Moving Photos

To copy photos:

1. Select the photos you want to copy in Thumbnail View.

2. Hold down the [CTRL] key on your keyboard and then drag the selected
photos.

3. Release the mouse button to drop the photos at the desired position.

To move photos:

1. Select the photos you want to move in Thumbnail View.

2. Drag the selected photos.

3. Release the mouse button to drop the photos at the desired position.

For Macintosh: Please use the [Command] key instead of the [Ctrl] key.

Discarding Photos & Films

1. Select the Photos you wish to discard.

2. Drag and drop the selected Photos onto the Trash-can icon .
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Or, select the Discard Selected Photo(s) command from the [Edit] menu.

The Photos will then be placed in the Trash-Can waiting for disposal or
retrieval.

Throwing out the Trash

1. Drag the films or photos you wish to discard to the trash can.

2. Select the Clean Trash Can command from the [Edit] menu. The
contents of the trash can will be deleted.

Or, place the mouse cursor over the rolled out Film list box. Click once with
the right mouse button.  Choose the Clean Trash Can command from the
pop-up menu.

The contents of the trash can will be deleted.

Note: In  the  [Clean Trash Can] dialog box,  i f  you choose
the  Yes but ton,  the  photos  in  the  t rash can wi l l  be
deleted from your hard disk forever.   That  is ,  you can
select  the No  but ton to discard the photos from Mr.
Photo,  i f  you wish to  keep the  photos  in  your  disk .
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Input Menu

Select Digital Camera Source
Selects the Driver of your Digital Camera.

From: lets you select a digital camera's driver.

To: sets the path of the folder that stores the pictures you load form the
selected digital camera.

Create a New roll of film: creates a new roll for the storage of loaded
pictures.

For Macintosh:

From the Selece Digital Camera Source submenu, select…

the Select TWAIN… or Select Plug-In… command to select the driver of
your digital camera.

the Digital Camera Input Setting command to pick out a specific directory
for the storage of the photos loaded from your digital camera.

Get Photos from a Digital Camera
Downloads photos from a digital camera. The [TWAIN Interface] dialog box
is called when this command is selected.

For Macintosh: Macintosh also supports acquiring photos from Plug-In
compliant devices.

Select Scanner Source
Selects the scanning source which will handle image acquisition.
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From: lets you select a scanner's driver.

To: sets the path of the folder that stores the pictures you acquire.

Create a New roll of film: creates a new roll for the storage of acquired
pictures.

For Macintosh:

From the Selece Scanner Source submenu, select…

the Select TWAIN… or Select Plug-In… command to select the scanner
driver.

the Scanner Input Setting command to pick out a specific directory for the
storage of the photos acquired from your scanner.

Acquire Photo from Scanner
Begins scanning an image from a scanner.  The Scan dialog box is called
when this command is selected.

For Macintosh: Macintosh also supports acquiring photos from Plug-In
compliant devices.

Add All Photos
Adds photos from the folder you select in your computer.

At the bottom of the [Add All Photos in Folder(s)] dialog box, there are three
check boxes.

Folders with Photos: Displays only the folders that contain photos. (For
Macintosh: This option is not supported.)

Include Sub-folder: Adds photos from the selected folder and the photos in
its sub-folders. (For Macintosh: This option is not supported.)

New Roll: Creates a new film for the storage of the photos you add.

Add Photo(s)
Selects photo(s) from your computer and adds the photos into Mr. Photo.
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Screen Capture
Choose to capture from area, window, or desktop.

For Macintosh: These options are not supported.

Area

Opens an application or a window whose display you wish to capture. Next,
select the Area option.  Finally, drag the cursor across the portion of the
display you want capture, and release the mouse key to capture it.

Window

This tool captures an application's window if the capture cursor is placed on
a window's title bar.  Otherwise, window objects bordered by a highlighted
perimeter will be captured.

Desktop

This tool captures the entire display as seen on your screen.

Exit
Select this command to leave Mr. Photo.

For Macintosh: Quit.

Edit Menu

For Macintosh: Please use the [Command] key instead of the [Ctrl] key.

Undo (Crtl + Z) / Redo (Crtl + Y)
Undoes / Redoes the last action.

Cut   (Crtl + X)
Removes a selected photo from the Thumbnail View and holds it on the
Clipboard ready to be pasted to other films.

Copy  (Crtl + C)
Copies selected photos and holds it on the Clipboard ready to be pasted to
other films.
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Paste (Crtl + V)
Pastes the photos you cut or copy onto a selected film.

Duplicate Pictures
Makes a copy of the selected photo.

Select All Photos (Crtl + A)
Selects all the photos in a film.

Select None
Deselects the current selections.

Search Photo(s)/Film
Searches for a particular film or Photo. The [Search] dialog box is called when
this command is selected.

Search Photos
Searches for particular photos.  In the [Easy Search] dialog box, enter one or
some keywords and then click the Search now button to start finding
photos.

For Macintosh: This option is not supported.

Create New Roll
Creates a new film.  Enter the details of the new film in the [Film Properties]
dialog box.

Film's Properties
Displays information regarding the selected film.

Photo's Properties
Displays information regarding the selected image.

Glossary Setting
Sets up a keyword database that will be used as a search index.
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You can add one or some keywords to your photos or films as a search.
From the [Photo's Properties] or [Film's Properties] dialog box, click the "+"
or "-" button to add/remove a glossary to/from your photo or film.

For Macintosh: This option is not supported.

Discard Selected Photo(s)
Discards selected photos.

Discard Selected Film
Discards selected films.

Clean Trash Can
Empties the trash can. This command is only enabled when there are Photos
to discard and you enter the Trash Can directory.

Add/Remove Applications
Add or remove applications to or from the Application Bar.

For Macintosh: This option is not supported.

Turn Sound Off
Switches off the sound effects.

For Macintosh: This option is not supported.

View Menu

Small
Displays twenty-five thumbnails at a time. This is the default option.

Medium
Displays nine thumbnails at a time.

Large View
Displays one large thumbnail at a time.
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Sort Films by
Contains commands shown below for arranging films in the List of Films.

Title  (Ascending)

Sorts films titles alphabetically.

Title  (Descending)

Sorts films titles in reverse alphabetical order.

Date  (Ascending)

Sorts films in chronological order.

Date  (Descending)

Sorts films date in reverse chronological order.

Sort Photos by
Contains commands shown below for arranging photos in the selected film.

Title  (Ascending)

Sorts photos titles alphabetically.

Title  (Descending)

Sorts photos titles in reverse alphabetical order.

Date  (Ascending)

Sorts photos in chronological order.

Date  (Descending)

Sorts photos date in reverse chronological order.

Film/Photo Tips
Enables/disables the picture tips feature.

Tool Tips
Enables/disables the tool tips feature.
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Photos’ Ordering Number
Select this option to enumerate the photos. A number will be placed at the
top left-hand corner of the photo indicating its order in the sequence.  Select
this option again to deselect.

Slide Show
Select this command to begin playing the slide show.

For Macintosh: This function is not supported.

Enhance Menu

Instant Enhancement
Select this command to call the [Instant Enhancement] dialog box.

Darken
Controls the overall Darkness of pixels in the Photo.

Lighten
Controls the overall brightness of pixels in the Photo.

Sharpen
Sharpens the borders and edges of an Photo.

Rotate Left
Rotates the Photo 90 degrees left.

Rotate Right
Rotates the Photo 90 degrees right.

Rotate 180
Rotates the selected photo clockwise by 180 degrees.
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Touch up
Brings a touch of magic to your photos. You can eradicate undesirable
blemishes such as red eye, improve the color on someone’s cheeks by
adjusting the hue, alter the contrast and brightness or put a golden tint on a
twilight scene.

Output Menu

Copy Files
Saves the selected Photos at a chosen destination such as a floppy diskette
or your hard disk. The [Copy Files] dialog box will appear when you select
this command.

Save as Wallpaper (Center)
Places a selected Photo in the center of the background of the desktop.

For Macintosh: This option is not supported.

Save as Wallpaper (Tile)
Arranges the selected Photo in a tiled pattern for the desktop background.

For Macintosh: This option is not supported.

Set as Screen Saver
Sets the selected Photo as a screen saver.

For Macintosh: This option is not supported.

Print Photos
Sends selected Photos to your printer.

Internet Menu

HTML Catalog
Outputting your photos in HTML format.  You can create home pages with
your photos, and share the HTML files with people on the internet.
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Make Thumbnail for Internet
Saves selected photos in a suitable format to be shown as Photos on a web
page. Selecting this command will open the [Make Thumbnails] dialog box.

Send via E-mail
Opens the e-mail facility and attaches selected Photos to the mail item.

Slide Show via E-mail
Creates an executable file that can be sent over Internet or e-mail. The
receiver simply runs the file to see a slide show. When this option is
selected, the [Portable Slide Show] dialog box will appear.

Download Pictures from PhotoNet
Gets your photos on a global access site called PhotoNet. As long as you
know the film key number (Film ID), you can upload your photos to the
PhotoNet Server or download photos from PhotoNet.

Upload Pictures to PhotoNet
Puts your photos on a global access site called PhotoNet. As long as you
give the film key number (Film ID) to your friends, he/she can download the
photos you upload.

Help Menu

Help Topics
Opens the on-line help for Mr. Photo.

Technical Support
U.S.A: NewSoft America Inc.

47470 Seabridge Drive, Fremont, CA 94538, USA

TEL: 1-510-445-8600

Fax: 1-510-445-8601

Technical Support Hot Line: 1-510-445-8616

E-mail: tech@newsoftinc.com

http://www.newsoftinc.com
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Taiwan: NewSoft Technology Corp.

9F, No.68. Sec.3, Nan-king E. Rd., Taipei, Taiwan, R.O.C.

Japan: NewSoft Japan Corp

6-21-3 Shinbashi Minato-Ku, Tokyo 105 Japan

NewSoft on the Web
Access to NewSoft’s Web site.

About...
Displays a message box with details about Mr. Photo.
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